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The Media page is the primary interface for media management and clip organization in DaVinci 
Resolve. It’s central to the way DaVinci Resolve works that the source media used by a project 
is organized separately from the project data that you import and manage in the Edit page. In 
this way, you can manage and update the clips used by timelines in the current project with ease, 
switching between offline and online media, reorganizing clips, and troubleshooting any problems 
that occur.

The Media page also contains much of the core functionality that will be used for on-set workflows, 
and in the ingest, organizational, and sound-synching steps of digital dailies workflows. This chapter 
covers most of the functionality found in the Media page, including functions in detail that are 
referenced throughout this manual.
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The Media page is the primary interface for media management and clip organization in DaVinci 
Resolve. It’s central to the way DaVinci Resolve works that the source media used by a project 
is organized separately from the project data that you import and manage in the Edit page. In 
this way, you can manage and update the clips used by timelines in the current project with ease, 
switching between offline and online media, reorganizing clips, and troubleshooting any problems 
that occur. 

The Media page also contains much of the core functionality that will be used for on-set workflows, 
and in the ingest, organizational, and sound-synching steps of digital dailies workflows. This chapter 
covers most of the functionality found in the Media page, including functions in detail that are 
referenced throughout this manual.

Understanding the Media Page User Interface
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The Media Page User Interface

The Media Page User Interface

The Media page is divided into six different areas, designed to make it easy to find, select, and work 
with media in your project.

Much of the functionality and most of the commands are found within the contextual menus that 
appear when you right-click clips in the Library, File Browser, or Media Pool.

Media page
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The Library

The Library browser shows a list of all volumes that are currently available to your Resolve workstation. 

It’s used to locate media that you want to import manually into your project. The list is divided into 
two categories of volumes:

>> Scratch volumes: Indicated by globe icon, these are disks that you’ve added to the Media 
Storage Volumes list of the Preferences window. The topmost of these scratch disks is used 
to store Gallery stills and cache files.

>> Available volumes: Indicated by disk icons, this is a list of all fixed, removable, and network 
volumes that are currently available to your workstation.

Library with scrubbable clip view
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The Library browser is a hierarchical list; clicking the disclosure triangle to the left of any volume 
opens up an additional list of that volume’s subdirectories, with additional disclosure triangles next 
to each subdirectory. Using the Library browser, you can drill down into as many subdirectories as 
you need to. 

Once you’ve selected a volume or subdirectory in the Library (volume browser), you can view the 
Library browser in List view or Icon view. In List view, the following columns are available for sorting 
media prior to importing it into the Media Pool:

>> File name: The name of a file.

>> Reel name: The reel name as it’s currently derived according to the Conform Options that 
are currently chosen in the Master Project Settings.

>> Start TC: The first timecode value in the source media.

>> Start: The first frame number in the source media.

>> End: The last frame number in the source media.

>> Resolution: The frame size of the source media.

>> FPS: The frame rate of the source media.

>> Audio Ch: The number of audio channels within the source media.

>> Date Modified: The date modified metadata from the source media file.

While in Icon view, you can scrub through a clip’s icon to see its contents, and you can also click the 
Clip Info pop-up menu at the bottom right corner of any clip’s thumbnail to see an instant summary 
of that clip’s vital information, including:

>> File name: The name of that file.

>> In timecode: The first frame in the source media.

>>Out timecode: The last frame in the source media.

>> Duration: The total duration of the source media.

>> Resolution: The frame size of the source media.

>> Frame Rate: The frame rate, in fps, of the source media.

>> Pixel Aspect Ratio: The aspect ratio of the source media.

>> Codec: Which codec is used by the source media.

>> Date Created: The date created metadata from the source media file.

>> Flags: Flag metadata applied either by the camera that shot the media, in the Metadata 
Editor, or in the Color page Timeline.
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Viewer

Clips that you select in any area of the Media page show their contents in the Viewer. A jog bar 
appears directly underneath the image, letting you drag the playhead directly with the pointer. The 
full width of the jog bar represents the full duration of the clip in the Viewer. The current position of 
the playhead is shown in the timecode field at the upper right-hand corner of the Viewer.

Simple transport controls appear underneath the jog bar, letting you Jump to First Frame, Play/
Stop, and Jump to Last Frame. 

A pair of buttons to the left of the transport controls let you choose between Playback mode, where 
you can examine clips, and Capture mode, in which you can cue up a device-controllable deck, and 
batch record from tape.

To the right of the transport controls, In and Out buttons let you set In and Out points for the 
current clip. The current In and Out points are indicated in the jog bar, and their timecode values, 
along with the resulting clip duration, are shown in the In, Out, and Duration timecode fields below. 
The Cue buttons move the playhead to these In and Out cue points. The clip’s timecode is also 
displayed at the top right.

Viewer
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Media Pool

The Media Pool contains all of the media that you import into the current project. It also contains any 
media that’s automatically imported along with Timelines that have been imported into Resolve. 

The Folder View

Ordinarily, all media imported into a project goes into the Master folder, however the Media Pool 
can be organized into as many user-definable folders as you like, depending on your needs. Media 
can be freely moved from one folder to another from within the Media Pool. When working in 
projects with multiple folders, you can choose to expose the folder structure in one of two ways:

>> Folder view open: The Folder View button at the bottom left-hand corner of the Media Pool 
lets you open a separate list view showing all folders in your project, hierarchically. Folders 
that contain other folders appear with a disclosure button to their left, that you can use to 
show or hide the contents. With the Folder view exposed, it’s easy to organize clips among 
a large collection of folders.

>> Folder view closed: When the Folder view is closed, all folders are hidden, and contents of 
whichever folder is currently selected populate the Media Pool browser.

Media Pool with the Folder View closed
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Filtering Folders Using Color Tags

If you’re working on a project that has a lot of folders, you can apply “color tags” to identify particular 
folders with one of eight colors. For example, you can identify the folders that have clips you’re 
using most frequently with a blue tag. A folder’s color tag then appears as a colored dot at the right 
of that folder’s name.  

Using Color Tags to identify folders

Once you’ve tagged one or more Media Pool folders, you can use the Color Tag Filter pop-up 
menu (the magnifying glass icon at the bottom right of the Media Pool’s Folder view) to filter out all 
but a single color of folder.

Media Pool with the Folder View open
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To go back to seeing all available folders, choose Show All from the Color Tag Filter pop-up.

Icon View and List View

The contents of the Media Pool can be browsed one of two ways:

>> Icon view: Each clip is represented by an icon, with its file name appearing underneath. 
When you move the pointer over a clip’s icon, Resolve automatically scrubs through that 
clip, showing you its contents. Also, a Clip Info pop-up menu appears in the lower right-hand 
corner. Click the Clip Info pop-up to see an overlay appear showing essential information 
about that clip.

>> List view: Each clip is represented by an item on a text list. Additionally, multiple columns of 
information appear, organized by headers. Clicking any header lets you sort the list by that 
column, in either ascending or descending order.

Using Color Tag filtering to isolate the red folder
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Metadata Editor

When you select a clip in any area of the Media page, its metadata is displayed within the Metadata 
Editor. If you select multiple clips, only the last clip’s information appears.

The Metadata Editor’s header contains uneditable information about the selected clip, including 
the file name, directory, duration, frame rate, resolution, and codec.

A series of editable fields underneath the Metadata Editor lets you review and edit the different 
metadata items that are available. A pop-up menu at the upper-right of the Metadata Editor lets 
you choose from many different sets of metadata fields and checkboxes, each grouped for a specific 
task or workflow.

Clip Metadata Editor
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Audio Panel

The Audio Panel can be put into one of two modes via a pop-up menu at the lower left corner. In 
the default Levels mode, Audio Meters are displayed that show the levels of audio in clips you’re 
playing. In Dailies mode, you can load audio clips side by side with video clips opened in the Viewer 
in order to sync them together manually. The Audio Panel can also be hidden.

When set to Levels mode, you can check audio embedded within clips you’ve imported into the 
Media Pool. DaVinci Resolve recognizes up to 16 tracks of audio within supported media formats. If 
you have a display with 2560x1440 resolution you can see all 16 corresponding audio meters, but on 
lower resolution displays only 8 audio meters appear in the Media page at a time. As you play a clip, 
each audio meter shows the levels for whichever of these tracks contain audio. You can toggle 
individual tracks on and off by clicking the track number underneath. A Mute button, to the left of 
the meters, lets you disable and enable audio playback.

Audio Meters Exposed

Tip: A setting in the Audio panel of the Project Settings window, “Audio Meter Alignment Level,” 
lets you redraw the dBU scale shown in all audio meters in Resolve to better reflect the reference 
alignment standard in your region of the world. This setting defaults to –20 dBFS, but can be 
adjusted from –24 to –15 dBFS.
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Dual Monitor Layout

The Edit page has a dual monitor layout that provides maximum space for the Library and Media 
Pool on the primary monitor, and an enlarged Viewer, Audio Panel, and Metadata editor on the 
secondary monitor, along with a complete set of video scopes for helping you to evaluate media as 
you organize it.

To enter dual screen mode:

>> Choose View > User Interface Layout > Dual Screen > On.

To switch which UI elements appear on which monitors:

>> Choose View > User Interface Layout > Primary Display > Display 1 or Display 2, which 
reverses the contents of both monitors in dual screen mode.

The Media page in dual-screen mode
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Customizing the Media Page

The Media Page can be customized to create more room in different areas to accommodate 
specific tasks.

To resize any area of the Media page:

>> Drag the vertical or horizontal border between any two panels to enlarge one and shrink 
the other.

Methods of hiding different parts of the Media Page:

>> To toggle the Clone Tool on and off: Click the button at the far left of the toolbar.

>> To toggle the Audio Panel on and off: Click the button at the far right of the toolbar.

>> To toggle the Media Pool folder list on and off: Click the button at the bottom-left of the 
Media Pool.

>> To toggle the Metadata Editor on and off: Click the button at the bottom-right of the 
Metadata Editor.

To return all pages to their default layout:

1.	 Open the Project Manager by clicking the Home button.

2.	 Right-click anywhere between the projects in the Project Manager, and choose Reset 
UI Layout.

3.	 Click Close.
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Copying Media Using the Clone Tool

One of the few things you may want to do before you add media to your project is to clone camera 
original media onto a safe set of volumes, with redundancy in case any one volume fails. Whether 
you’re on-set working as a DIT, or doing data ingest at a post facility, the Clone Tool lets you safely 
and accurately copy media from SD Cards, SSDs, or disk drives, to multiple destinations, with a 
checksum report written to the root of each destination volume that verifies the absolute accuracy 
of the duplicate media saved to each destination.

To duplicate media using the Clone Tool:

1.	 Open the Clone tool by clicking the Clone button at the far left of the Media Pool tool bar, 
which reveals the Clone tool palette. 

2.	 Click the plus (+) button at the bottom left to create a new job. A job item appears within the 
Clone Tool Palette, with overlays to guide you through its use.

3.	 Drag a volume or folder from the Library to the “Drop source here” drop zone. Alternately, you 
can right-click any volume or folder in the Library and choose Set As Clone Source.

4.	 Next, drag one or more volumes or folders from the Library to the “Drop destination here” 
drop zone. Alternately, you can right-click any volume or folder in the Library and choose Set 
As Clone Destination. You can have more then one destination. 

5.	 If you want to preserve the name of the top directory in the source volume or folder, click the 
Clone tool panel’s option menu and choose “Preserve Folder Name.” 

6.	 When you’re ready, click the Clone button to initiate the cloning process.

The Clone Tool with a job set up
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Adding and Removing Media

At minimum, you’ll be using the Media page to add clips to a project for further processing. All 
clips you want to work with must first be added to the Media Pool to be available for grading 
and processing in DaVinci Resolve, regardless of whether or not there’s edited project data to go 
along with it.

If you import XML or AAF projects, you can choose to automatically import all accompanying media 
as part of the import process you initiate in the Edit page. However, if you find yourself needing to 
replace updated effects or stock footage in the Timeline, or you’re called upon to add additional 
media such as animated titles or superimposed clips for compositing, then you’ll still need to use 
the Media page to do so. 

Whatever kind of project you’re working on, you can add clips to the Media Pool from as many 
different volumes as you need. All imported clips are linked to the original media on whichever 
disks you found them; files are not moved, copied, or otherwise transcoded when you add them to 
the Media Pool. Consequently, it’s a good idea to make sure that all media you want to import into 
your project has already been copied to a suitably fast volume before importing it.

Important: Before you add media to a new project, if you’re not importing a project via an AAF 
or XML file, you need to make sure that the “Timeline frame rate” setting in the Master Project 
Settings is set to the same frame rate as the incoming media, since you cannot change this after 
media has been added to the Media Pool.

There are several ways of adding clips to the Media Pool by selecting them yourself.

To add individual clips to the Media Pool:

1.	 Use the Library to find a media file to import. 

2.	 Do one of the following:

>> Double-click that file to add it as a clip to the currently selected folder in the Media Pool.

>> Shift-click or Command-click multiple files, then right-click one of the selected files and 
choose “Add into Media Pool.”

3.	 When a dialog appears asking if you want to change your project to match the criteria, click 
“Change” to alter the project’s settings, or click “Don’t Change” to continue importing the 
media while leaving the project at its previous frame rate. Once clips have been imported into 
the Media Pool, the frame rate cannot be changed again, so choose carefully.

To add the contents of a directory of clips to the Media Pool:

1.	 Use the Library to find the directory containing the files you need to import.

2.	 Do one of the following:

>> Right-click the directory and choose Add Folder into Media Pool to add only clips from the 
selected directory. Subdirectories are ignored.
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>> Right-click the directory and choose Add Folder and SubFolders into Media Pool to add 
clips from the selected directory, and all subdirectories within.

>> Drag the folder you want to the browser area of the Media Pool to add its contents to the 
currently selected folder in the Folder View.

To add all clips and folders in a directory organized into matching folders in the Media Pool:

1.	 Use the Library to find the directory containing the files you need to import.

2.	 Do one of the following:

>> Right-click the directory and choose “Add Folder and SubFolders into Media Pool 
(as Folders)”

>> Drag the folder you want to import from the Library to the Folder View of the Media Pool to 
add that folder, and all subfolders within, as a new folder in the Folder View.

A folder appears in the Media Pool with the same name as the folder you dragged in. All 
clips and all subdirectories appear within, nested hierarchically in the Media Pool as they 
were in the file system.

Adding Media Based On EDLs

Another strategy for adding media to the Media Pool is to use an EDL to add only the clips it refers 
to from a directory. This lets you add only the clips that are necessary for conforming a particular 
imported project before conforming an EDL, and eliminates the need to add too much media to 
the Media Pool, which might slow you down in the case of projects referencing terabytes of media. 
Furthermore, you can choose multiple EDLs to base the import on, and many directories to examine.

The EDLs will reference clips via their timecode and sometimes reel name and path. It is these 
settings and the conform frame rate that you made previously in the Configuration screen that are 
now used to place images correctly into the Media Pool.

To add only media used in an EDL to the Media Pool:

1.	 If necessary, open the Master Project Settings panel of the Project Settings, turn on the “Assist 
using reel names from the” checkbox, and choose a method with which to extract reel name 
information from the media files you’re about to import. For more information, see Chapter 9, 
“Preparing and Conforming Projects.”

2.	 Right-click a directory in the Library browser, and choose one of the following commands:

>> Add Folder Based on EDLs into Media Pool

>> Add Folder and SubFolders Based on EDLs into Media Pool

3.	 Using the file dialog that appears, select one or more EDLs to use.

	 Resolve searches the directory hierarchy, either one level or all levels, for every media file 
matching the source timecode and the reel ID of an event in one of the selected EDLs.
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Splitting Clips Based on EDLs

You can also use EDLs to split a media file into multiple clips in the Media Pool, either as an alternate 
means of “preconforming” a flattened master media file, or to import multiple sections of a longer 
media file that happen to be referenced by an EDL.

To split and add clips based on an EDL:

1.	 Right-click a directory in the Library browser, and choose “Split and add into Media Pool.”

2.	 Using the file dialog that appears, select an EDL to use, and click Open.

3.	 Choose a frame rate to use to conform the clips to in the “File Conform Frame Rate” dialog, 
and click OK.

4.	 Choose a handle size, in frames, and whether or not you want to split unreferred clips from the 
“Enter handle size for splitting” dialog, and click Split & Add.

	 Tip: Turning on the Split Unreferred Clips checkbox automatically splits out sections of the 
file that were not referred to by the EDL you selected, and adds them to the Media Pool 
separately, giving you access to every piece of media that’s available.

	 The media file is split into the component clips specified in the EDL, and added to the 
Media Pool.

Adding Media With Offset Timecode

Sometimes source media was created with incorrectly offset timecode, due to mistakes made 
earlier in the postproduction process. If this offset is consistent, you can use the “Add Folder with 
Source Offset” command to add media to the Media Pool as clips with a timecode offset.

To add a folder of clips to the Media Pool with offset timecode:

1.	 Right-click a directory in the Library browser, and choose one of the following commands:

>> Add Folder with Source Offset

>> Add Folder and SubFolders with Source Offset

2.	 Choose a number of frames with which to offset the timecode from the “Change Frame 
Offset” dialog, and click Apply.

	 The media is imported as clips with offset timecode in the Media Pool. However, the original 
source timecode of the clips on disk has not been altered. All media rendered out of the 
Deliver page will reflect the offset timecode.
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Removing Media From the Media Pool

If you’ve added clips to the Media Pool that you need to eliminate, this is easy to do, either singly, 
or in the aggregate.

To remove clips from the Media Pool:

>> Select one or more clips in the Media Pool, right-click one of the selected clips, and then 
choose Remove Selected Clips

>> Right-click anywhere in the Media Pool, and choose Remove All Clips in Bin

Note: If you’ve turned on “Automatically match master timeline with media pool” in the General 
Options panel of the Project Settings, you cannot remove all clips from the Media Pool if there are 
other timelines using that media.

To remove clips from the Master Timeline:

>>Open the Edit page, then select one or more clips in the Media Pool, right-click one of the 
selected clips, and choose “Remove Selected Clips from Master Timeline.”

Adding and Removing External Mattes

If you’ve been provided with matte files to accompany one or more media files used by a program 
you’re grading, you can attach them directly to specific clips in the Media Pool, in order to use them 
as key sources for a Clip Grade in the Node Editor of the Color page. You can even use matte files 
that pack multiple mattes within a single piece of media. This can be done by either writing different 
mattes to each of the red, green, and blue channels of a clip, or by embedding multiple matte 
passes within a single OpenEXR file.

 

Matching RGB and Matte images
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Attached mattes appear listed underneath a clip in the Media Pool.

An attached matte, seen in List view

Alternately, you can add an unattached matte clip to the Media Pool, which isn’t attached to any 
clip, that can be used as a key source in the Color page within any clip’s Clip grade, or within a 
Timeline Grade. Unattached matte clips appear as stand-alone clips in the Media Pool. 

An unattached matte, seen in Thumbnail view

Matte files are useful for two things. Traditionally, mattes are grayscale media files that identify 
regions of varying opacity, with white representing solid areas, and black representing transparency. 
However, mattes can also be used as creative tools to apply grain and texture for effect. What a 
matte does depends on how you connect it in the Node Editor of the Color page.

If you have a clip from a VFX system there is occasionally an associated matte file. By using ‘Add 
as Matte’ you place the file in the Media Pool with the correct identification, shown as a Mask icon 
so that DaVinci Resolve can use the file as a matte. After you have placed the main image clip into 
the Media Pool, highlight the clip. Then find the matte in the Clip Details display, right-click on that 
matte and select ‘Add as Matte.’ In the Media Pool, the main clip will have a cyan box just before the 
clip name and if you double-click the main clip, the associated matte will be shown with the Mask 
icon; it is linked to the main clip.



DAVINCI RESOLVE COLORIST REFERENCE MANUAL

136

MEDIA4

To add an assigned matte to a clip in the Media Pool:

1.	 Select a clip in the Media Pool to which you want to attach an external matte.

2.	 Select the matching external matte file in the Library browser, right-click it, and choose Add  
as Matte.

	 The external matte is attached to the clip, and can be seen if you put the Media Pool into List 
view as a nested item underneath that clip. 

Removing external mattes from clips in the Media Pool:

1.	 Put the Media Pool into List view.

2.	 Right-click the external matte file you need to remove, and choose Remove Selected Clips.

	 Removing an external matte clip also removes that matte’s key from any clip grades that use 
it, such that any clips using it as a key input change from a secondary operation to a primary 
operation, where the color adjustment affects the entire image.

To add an unassigned matte to the Media Pool:

1.	 Make sure no clip is selected in the Media Pool.

2.	 Select an external matte file in the Library browser, right-click it, and choose Add as Matte.

	 The external matte appears in the Media Pool, unattached.

For more information on using external matte clips as keys when grading, see the “External Mattes 
to Add Texture” section of Chapter 12, “Advanced Color Features.”

Adding Offline Videos

If a client has output the offline edit of an entire program being graded as a single media file for 
use as an Offline Reference Movie, you can import this file in a special way to use it for dual Viewer 
comparison in the Edit page, or in split-screen comparisons in the Color page.

To add a clip as an offline clip, right-click it in the Library browser, and choose “Add As Offline Clip.” 
That clip appears with a small checkerboard badge in its icon in the Media Pool, or as the icon to 
the left of the Media Pool.
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For more information on using an Offline video to compare with a conformed Timeline in the Edit 
page, see Chapter 6, “Edit.” For more information on split-screen reference of Offline video in the 
Color page, see Chapter 11, “Color Page Basics.”

Checkerboard icon indicating an Offline comparison video
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Whether you’re doing onset work, creating digital dailies, organizing media to edit, or ingesting 
media to conform to an imported project, it’s vitally important to stay organized. The Media Pool 
provides many different tools for doing so.

Organizing Media into Folders

You can easily organize clips into different folders in the Media Pool. For some workflows, this is 
required, while with other workflows it’s purely optional.

Methods of working with folders in the Media Pool:

>> To add a folder to the Media Pool: Click the + button at the bottom left of the Media Pool. 
Or, right-click the background of the Media Pool and choose Add Folder. To add a folder 
inside of another folder, select a folder first, then either click the + button, or right-click and 
choose Add Folder.

>> To rename a folder: Select the folder you want to rename, and then click its name a second 
time to make it editable. With the folder name highlighted, type a new name and press 
Return. Alternately, you can right-click a folder, choose Rename Folder, and then type a 
new name and press Return.

>> To add incoming clips to a specific folder in the Media Pool: Click a folder to select it, then 
use any of the previously described methods to add media from the Library directly to 
that folder.

>> To move media from one folder to another: Drag one or more selected clips from their 
current location in the Media Pool into that folder. Multiple clips in the Media Pool can be 
selected by Shift-clicking or Command-clicking them, or by dragging a bounding box over 
a group of clips. You can also drag one folder into another one.

>> To delete a folder: Select the folder you want to delete, and click the – button at the bottom 
left of the Media Pool. Or, right-click a folder and choose Delete Folder. Deleting a folder 
with nested folders inside of it results in that entire set of folders being deleted.

Using the Media Pool in Icon View

If you work in Icon View using the controls at the top right of the Media Pool, you have the option to 
resize the thumbnails to make them easier to see, and you can move the mouse pointer over each 
clip to hover scrub through its contents. Clicking any clip to select it displays it in the Media page 
Viewer. Whichever clip is currently selected is also output to video for monitoring.

Organizing the Media Pool
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Working With Columns in List View

If you work in List view using the controls at the top right of the Media Pool, you gain additional 
organizational control by exposing columns that show the metadata that each clip contains. You can 
use these columns to help organize your media.

Methods of customizing metadata columns in List View:

>> To show or hide columns: Right-click at the top of any column in the Media Pool and select 
an item in the contextual menu list to check or uncheck a particular column. Unchecked 
columns cannot be seen.

>> To rearrange column order: Drag any column header to the left or right to rearrange the 
column order.

>> To sort by any column: Click the column header you want to sort with. Each additional 
time you click, the same header toggles that column between ascending and descending  
sort order.

While these columns of metadata correspond to those fields shown in the Metadata Editor, the 
available columns in the Media Pool of the Media and Edit pages are a subset of the total amount 
of metadata that’s available, although they represent the most commonly used metadata you’ll find 
yourself referring to when editing and finishing. Available columns in List view include:

>>Name: The file name of that clip.

>> Reel Name: The reel name of that clip. Dynamically generated by the “Assist using reel 
names from the” setting of the Master Project Settings.

>> Start TC: The timecode value of the first frame in the media file.

>> End TC: The timecode value of the last frame in the media file.

>> Duration: The total duration of the clip, in timecode.

>> Start: The first frame number of the media file.

>> End: The last frame number of the media file.

>> Frames: The total duration, in frames.

>> Resolution: The frame size of the media file.

>> FPS: The frame rate of the media file.

>> Audio Ch: The total number of audio tracks in the media file.

>> File Path: The file path where that media file is located on disk.

>> Codec: The codec used by the media file.

>> Flags: Which flags, if any, have been added to a media file.
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>> Usage: After a Timeline has been created by importing an AAF, EDL or XML project, you can 
right-click the Media Pool and choose “Update usage” to refresh the information shown 
in the Usage column to reflect how many times each clip is used in the project. This makes 
it easy to identify clips that aren’t in use, and which can be removed from the Media Pool.

>> IDT: If ACES color science is selected in the Master Project Settings, the IDT used by that 
clip is listed here.

>> Input LUT: Which Input Look-Up-Table has been assigned, if any.

>> PAR: The Pixel Aspect Ratio, if assigned.

>> Data Level: The data level setting for the media file.

>> Date Created: The date the media file was created.

>> Date Modified: The last date the media file was modified.

>> Slate TC: The Slate timecode track used to sync audio with video.

>> Description: A user-editable field for entering information about that clip.

>> Comments: A user-editable field for entering information about that clip.

>> Keyword: A user-editable field for entering searchable keywords pertaining to that clip.

>> Shot: An editable field to contain the shot number of the media, relative to the scene.

>> Scene: An editable field to contain the scene number of the media, relative to the script.

>> Take: An editable field to contain the take number of the media, relative to the shot.

>> Angle: An editable field to contain the angle of the media in a multi-camera shoot.

>> Circled: An editable field to contain the circled state of media, relative to the script 
supervisor’s notes.

>> Roll/Card: An editable field to contain the roll number of media that was scanned from film.

>> HDRX: For R3D media, indicates whether it’s HDRX media.

>> Frame/Field: Whether that media file is progressive or interlaced.

>> H-FLIP: Whether that media file is horizontally flipped in Resolve.

>> V-FLIP: Whether that media file is vertically flipped in Resolve.

>> LUT: The LUT that’s currently applied to that media file in Resolve.

>> Input Sizing Preset: The currently selected Input Format Preset, if there is one.

>> Start KeyKode: The starting KeyKode value of a scanned negative.

>> Duration: The duration of the media file.

>> Bit Depth: The bit depth of the media file.
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>> Sample Rate: The sample rate of the media file’s audio, if there is any.

>> S3D Sync: Shows a frame count when you slip an eye to fix non-synced timecode using the 
“Slip Opposite Eye One Frame Left/Right” commands. This parameter is editable in the 
Media Pool.

>> Audio Offset: Lists the audio offset, in frames, for clips that have been synchronized to 
separately recorded audio. This parameter is editable in the Media Pool.

Finding Media in the Media Pool

The Search Field at the upper right-hand corner of the Media Pool can be used to locate one or more 
clips based on the metadata that’s selected in the Search Options pop-up menu to the left of it.

The Search Options pop-up menu (as seen in the Edit page Media Pool)  

lets you choose what metadata you’re searching

To find a clip in the Media Pool, first choose a criteria from the Search Options pop-up menu at 
the top right of the Media Pool; you can choose All Fields to do a simultaneous search of every 
metadata column in the Media Pool at once, or you can choose a specific criteria to restrict your 
search. Then, type a search term in the Search field. As soon as you start typing, all clips that don’t 
match the search criteria are temporarily hidden. To show all clips in the Media Pool again, click the 
cancel button at the right of the search field.
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Whenever you select a clip in the Media Pool, its editable metadata appears in the appropriately 
named Metadata Editor. You can use this editor to further massage the metadata of the clips in a 
project, adding information on set that will be of help later during editing and finishing. 

By default, clips initially appear with a set of clip metadata called “Clip Details,” that shows 
some of the most fundamental details of the clip such as start and end timecode, duration, bit 
depth, etcetera.

A pop-up menu at the upper left corner of the Metadata Editor lets you choose from multiple sets 
of metadata. Each set has individual fields and checkboxes that you can populate with different 
kinds of information.

A pop-up menu at the upper left corner of the Metadata Editor lets you choose from multiple sets 
of metadata. Each set has individual fields and checkboxes that you can populate with different 
kinds of information. 

Metadata Editor displays selected clip and editable items

Editing Clip Metadata
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If you want to see a list of every piece of metadata in a clip, you can choose All Groups. Otherwise, 
you can choose any set of metadata to narrow your focus to just those items of information.

To edit the metadata of a single clip:

>> Select a clip, choose a metadata set using the pop-up menu, and then type into any field 
or click any button. 

To edit the metadata of multiple clips:

1.	 Choose a metadata set using the pop-up menu in the Metadata Editor.

2.	 Select multiple clips in the Media Pool by Shift-clicking, Command-clicking, or dragging a 
bounding box around them.

3.	 You can click the checkboxes to the left of the labels of any items you want to edit in the 
Metadata Editor, or you can simply start making your edits and the appropriate checkboxes 
will be turned on automatically.

4.	 Click Save, or Revert if you want to back out of your changes.

Metadata categories pop-up menu
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If you’re processing dailies for a shoot that used dual-system recording, where audio is recorded 
to a separate device than video, you can sync the dailies in DaVinci Resolve in one of two ways. 
Synced clips can be output as media files with embedded audio, or output to tape, whatever your 
client requires.

Batch Syncing Dailies Using Timecode

Ideally, if the sound recordist on set was highly organized, and the camera and audio recorder both 
used synchronized timecode, you can use a single command to automatically sync every clip in a 
Timeline to a folder of Broadcast .wav files that have matching timecode.

To batch sync dailies:

1.	 Create a new project, open to the Media page by default, and import the video media you 
need to sync into any folder of the Media Pool.

2.	 Import the matching Broadcast .wav files into the same folder as the accompanying video 
media you imported in Step 1. If you want to stay more organized, you can create another 
folder to contain the audio clips, but it must be inside the folder containing the video files. The 
audio folder can be named anything you like.

3.	 Right-click the folder containing the matching audio and video clips, and choose one of the 
following commands from the contextual menu:

>> Auto-Sync Audio Based On Timecode: Replaces the media file’s previous audio tracks with 
the newly synced .wav files.

>> Auto-Sync Audio Based On Timecode and Append Tracks: Adds new tracks in addition to 
the audio tracks that were previously in the media file.

The Media Pool showing a folder containing both video clips and an Audio folder 

containing the Broadcast WAVE files to be synced

Syncing Audio
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	 Every clip in the selected folder for which there was an accompanying Broadcast .wav file with 
matching timecode is immediately synced with an audio track. All synced clips appear with an 
audio icon at the bottom left in the Media Pool when icon view is selected. Now that the clips 
are synced, you can edit them in the Edit page, or use the Deliver page to export offline dailies 
or online media with embedded synch audio for use in other applications.

Individually Syncing Clips in the Timeline

If you have a collection of WAV or AIFF audio files with video source media that lacks matching timecode, 
you need to manually sync each pair of media files together, one-by-one, using a sync reference such 
as the clap of a clapperboard, or any other sharp sound with a distinct audio/visual correspondence.

To manually sync dailies:

1. 	 Create a new project, and set change the project settings so that the timecode set by the “Timeline 
frame rate:” parameter of the Conform Options matches the timecode of your media. Now’s a 
good time to set the Timeline resolution to match the resolution of your media, as well.

2.	 Import the video media you need to sync into the Media Pool.

3.	 If you want to stay organized, create a second bin in the Media Pool, named Audio Clips, and 
import the matching Broadcast .wav files into it. The name of the bin is not important, and 
having all the audio in one bin is simply a matter of convenience.

4.	 Set the Audio Panel mode pop-up menu in the Media page to Dailies, which lets you view and 
scrub along the waveform of audio clips you select in the Media Pool.

5. 	 Select a video clip to sync, and move the Viewer playhead to line up with the first visual sync point 
in the first clip. This could be the clap of a clapper board, the red flash of a tablet computer’s 
slate app, a hand clap, or any clear visual cue to which there is a corresponding audible sound.

6.	 Now, select whichever audio clip matches the current video clip in the Viewer, to open its 
waveform into the audio panel.

7.	 Use the Audio panel transport controls and scrubber bar in the Source Viewer to move the 
playhead to the audio sync point that corresponds to that video sync point. This may be a 
clap, a beep, or some other staccato sound that’s easy to sync to. As you play through the 
clip, the bottom half of the Viewer shows a zoomed out waveform for the entire clip, while the 
top half of the Viewer shows a zoomed in section of the waveform that immediately surrounds 
the playhead. Hopefully, the sync point you’re looking for is a distinct, loud spike somewhere 
towards the beginning or the end (in the case of a tail slate) of the audio clip.
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8. 	 When you’ve found the audio sync point that matches the video sync point, click the Link/
Unlink Audio button to embed the now synched audio into the video clip.

Clicking the sync link button to lock sync

The audio and video items are linked. At this point, you can use the newly synced clips in the Edit 
page, and use the Deliver page to export offline or online media with embedded audio for editing.

Offsetting the Sync of Previously Synched Clips

If you need to offset the audio sync later on, you need only select the synced clip you want to resync 
in the Media Pool, then set the Audio Panel to Dailies mode, turn off the linked clip button, change 
either the audio or video sync points, and turn the linked clip button back on again. 

You can also use two sets of commands for slipping the sync of any clip:

>> Edit > Slip Audio/Eye > Slip Audio One Frame Forward/Reverse: (Option-period and 
Option-comma) Slips the audio/video sync of any clip in whole frame increments.

>> Edit > Slip Audio/Eye > Slip AudioOne Subframe Forward/Reverse: (Option-right arrow 
and Option-left arrow) Slips the audio/video sync of any clip in 1/10th frame increments.

Aligning video and audio sync points with the Audio Panel Set to Dailies mode
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Using the Clip Attributes window, you can alter additional attributes for multiple clips all at once. 
This window has some overlap with other clip attributes that are editable directly from submenus 
within the Media Pool clip contextual menu.

To edit the attributes of one or more clips:

1.	 Select one or more clips in the Media Pool by Shift-clicking, Command-clicking, or dragging a 
bounding box around them.

2.	 Right-click one of the selected clips, and choose Clip Attributes.

3.	 Click one of the categories in the sidebar at the left to reveal a page of the attributes you want 
to edit. If you’ve selected multiple clips, then click the checkboxes to the left of the ones you 
need to edit, and make your alterations.

4.	 When you’re finished, click OK to accept the changes.

The Clip Attributes window has five sets of attributes that you can edit.

Clip attributes window

Changing Clip Attributes
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Video Attributes

These affect individual clip frame rate, geometry, and data levels.

>> Video Frame Rate: In cases where a clip’s frame rate was specified incorrectly in another 
application, or if there is no frame rate metadata available at all, you can change the frame 
rate here.

>> Levels: In certain circumstances, you may find that you need to manually choose appropriate 
data levels for clips that are not being interpreted correctly, choosing between “Video 
Level” and “Data Level.” For more information on this setting, and how it affects the image 
data in your project, see Chapter 9, “Preparing and Conforming Projects.”

>> Pixel Aspect Ratio: In projects using a mix of media with different frame sizes, you can 
assign specific pixel aspect ratios using this pop-up menu.

>> Horizontal and Vertical Image Flip: Modifies the horizontal and vertical image flip camera 
metadata for r3d clips, which is useful for stereoscopic 3D projects shot with a mirrored 
camera rig that reverses the media from one eye, or in cases where steadicam rigs result in 
upside-down clips. These settings are different from the Flip Image controls in the Sizing 
palette of the Color page.

>> Input Format Preset: You can use this panel to assign a Sizing palette preset to select 
clips. For example, if you have a special Input Format Preset for standard definition PAL 
widescreen clips that you’ve edited into a high definition project, you can do a sort in the 
Media Pool to isolate them, and then select them all and apply this preset.

>> Select Alpha Mode: The options presented here depend on the format of the clip you’ve 
selected, since only certain formats (such as ProRes 444, OpenEXR, TIFF sequences, 
etcetera) are capable of containing alpha channels. If you’ve imported clips with embedded 
alpha channels, this panel lets you enable or disable their use in Resolve, choose the type 
of alpha channel (Premultiplied or Straight), or invert the alpha channel.

Timecode Attributes

If you find yourself dealing with clips that have incorrect timecode, or timecode with an incorrect 
relationship to the EDL, XML, or AAF project you’ve been given, you can use these attributes to 
modify the timecode and reel name of clips in the Media Pool. None of these tools alter the source 
media on disk. They simply change the timecode metadata in your Resolve project, which by 
extension affects the timecode of any media you render.

>> Start Timecode: Lets you assign a new time for the timecode at the currently viewed frame 
of the clip.

>> Slate Timecode: In situations where source media comes from a shoot where a timecode 
slate was used during the shoot, then you can assign the slate timecode as a second 
timecode track that can be used for various operations, without changing the primary 
timecode of the clip, which may already be in use for program sync. 
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To set appropriate Slate timecode, select a clip in the Media Pool with a visible timecode 
slate, and move the playhead to a frame where the timecode in the slate is clearly readable. 
Then, open the Timecode panel of the Clip Attributes window, and type the timecode 
value you see in the image into the Slate Timecode field.

>>Offset Source Timecode: If an entire set of clips has timecode that’s merely offset, you can 
correct the timecode offset for as many selected clips as you like.

Reel Name Attributes

The Master Project Settings window has a Master Project Settings panel with Conform Options 
parameters that provide options to extract reel names for clips in a variety of ways. These options 
are dynamic, and whenever you change them they affect every clip in your project.

You must first choose a Reel Assist setting in the Master Project Settings window for the Clip 
Attributes window to be editable,.

>> Source clip file pathname and Pattern: Functions identically to the Pattern setting discussed 
in Chapter 3, “Project Settings, Caching, and Preferences.”

>>Media Pool folder name: Lets you use the name of the folder that currently encloses that 
clip in the Media Pool as the reel name.

>> Embedding in source clip file: Lets you forcibly extract the reel name metadata from the 
header of the clip’s corresponding media file on disk.

>> Source clip filename: If there is no defined reel number often it’s easy to just use the source 
clip filename.

>> User defined: Use this option to enter whatever string you want.

Audio Attributes

The Audio panel lets you alter the channel format and channel assignments for one or more clips. 
These settings affect what appears in the audio tracks of the Timeline when you edit a clip. When 
you first import clips into the Media Pool, you can use the Audio Attributes panel to define which 
embedded audio tracks can be used for editing, and how they will appear in the Timeline.

>> Number of Audio Tracks: Shows how many channels (or tracks) of embedded audio 
a clip has.
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>> Channel Format: A pop-up that lets you choose what format a clip’s audio uses. The setting 
you choose here affects how many channels appear in the Channel Assignments list below, 
as well as how audio clips appear in the Timeline, and what kind of Timeline audio track 
will be required to contain them. The available options are Mono (appropriate for single-
channel clips), Stereo (appropriate for clips with two-channel left/right audio), and 5.1 
(automatically used for any clips with more then two channels, appropriate for 5.1 surround 
mixes). If you choose a Channel Format with fewer channels than are embedded in a clip, 
all extraneous channels will be disabled.

>> Channel Assignments list: his list shows you a line for each channel made available by 
the selected Channel Format. A pop-up menu lets you change which embedded clip 
audio channel is mapped to each available track as determined by the Channel Format. 
Alternately, you can disable channels you don’t want to use by choosing Mute.
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Managing media directly from within DaVinci Resolve lets you quickly take care of issues that can 
arise with the media in a project.

Relinking Media Using Change Source Folder

When you’ve used your file system to move media that’s used as a source clip in a Resolve project, 
you can use the ‘Change Source Folder’ command to relink one or more selected clips in the Media 
Pool to the new file path of the media.

To relink your Media Pool clips to a new location:

1.	 Select one or more clips in the Media Pool, right-click one of the selected clips, and choose 
‘Change Source Folder.’ 

	 The Relink Media window appears displaying the original path for the material, with controls 
for choosing a new directory.

2.	 Click the “…” button to the right of the “Change To” field, and then use the file navigation 
dialog to find the new location of the media file, select it, and click Open.

3.	 If you succeeded in finding the appropriate media file, click Change. Otherwise, click Cancel.

Locating Media Files in the Media Library and in the Finder

If you find yourself needing to determine the location of a clip’s source media file on disk, you can 
right-click an item in the Media Pool and choose Reveal in Media Library. The Library automatically 
opens to the folder containing the media file you’ve selected, with that media file selected in the 
Library browser to the right.

Another feature that’s only available for OS X systems is the ability to right-click an item in the Media 
Pool and choose Reveal In Finder. A file system window opens up, revealing the media file that clip 
is linked to.

Copying Clips Between Volumes

You can copy media from one disk location to another right from within the Media Pool, without 
needing to exit DaVinci Resolve to go back to the file system. 

1.	 Right-click a clip or folder in either the Media Pool or Library, and choose Copy.

2.	 Locate a destination directory in the Library, then right-click it and choose Paste.  

	 The Clip Task Manager window opens, with controls that let you either start or prioritize the 
Copy operation. 

Media Management
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3.	 Choose one of the following operations by clicking the corresponding button:

>>Move Up and Move Down: Two buttons let you move selected Copy operations up or 
down in the queue to prioritize when they’ll get done.

>> Start Processing: Initiates the process of copying the specified media.

>> Remove Finished: Removes finished Copy operations from the queue.

>> Remove Selected: Removes any Copy operations you’ve selected from the queue.

>> Reset Selected: Resets finished Copy operations you’ve selected from the queue in order 
to initiate them again.

>> Cancel Selected: Cancels the selected Copy operations so you can finish them at a 
later time.

>> Select All: Selects all Copy operations in the Clip Task Manager queue.

	 Note: If copy operations change the directory structure, or files and folders have been added 
to a volume, you may need to right-click the Media Storage display and choose “Refresh.”

Updating Timecode for Audio - LTC

Some cameras do not offer the ability to sync to an external timecode source. Their recorded 
timecode may be time of day or free run timecode, but it would not be frame accurately synced to 
other cameras, the dual system audio recorder or the digital slate. This makes multi-cam or dual 
sound system syncing a time consuming manual operation.

DaVinci Resolve offers a solution to this problem if, by connecting an externally generated timecode 
to the camera audio input, the video that’s recorded by the camera has a timecode reference 
recorded on the audio track during the shoot. 

Select this clip, or clips, in the media pool, then right-click on one of the highlighted clips and 
select “Update timecode from audio - LTC.” Resolve automatically and instantly updates the clip 
timecode using the LTC it finds on the audio tracks. You can now use the clips as though they were 
synced on set.

Creating Subclips

Subclips give you another way of organizing media in the Media Pool, letting you break excessively 
long clips into shorter ones. For example, if the director of a project is fond of “rolling takes” where 
multiple takes are all recorded within a single clip, you can break these takes up by making them 
into subclips.
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To create a subclip:

1.	 Select any clip in the Media Pool to open it into the Viewer.

2.	 Set In and Out points to define the section you want to turn into a subclip.

3.	 Right-click the jog bar and choose Make Subclip. 

	 A new subclip appears in the Media Pool, automatically selected so that you can immediately 
edit its metadata in the Metadata Editor.

Once created, subclips appear and work like any other clip in Resolve.
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Proxies are lower-resolution versions of the media files in your project that can be used in cases 
when your workstation lacks the horsepower to do the work you need to accomplish in real time. If 
you find yourself in a situation where real time performance is unable to keep up with the number 
of operations you’re trying to use in a grade, you can activate proxy mode.

To activate proxy mode, do one of the following:

>> Choose View > Proxy On The Fly (Command-P).

>>Click the Settings button, click Image Scaling, and turn on the “Use real time proxies” checkbox. 

>> Press the PROXY ON/OFF button on the DaVinci Resolve T-bar panel

When you activate proxy mode, DaVinci Resolve will do one of two things, depending on whether 
or not you’ve created proxy media in advance. Ordinarily, DaVinci Resolve will generate on-the-fly 
proxies at the resolution specified in the Image Scaling panel of the Settings window. 

However, if you first create pre-generated proxies, DaVinci Resolve will use them instead. Proxies 
may be generated at any time from DPX source media. 

Tip: When generating proxies, half or quarter of the resolution is recommended to obtain 
maximum speed. 

To add clips to the Proxy Manager, do one of the following:

>> Select one or more clips in the Media Pool, then right-click one of the selected clips, and 
choose Add Into Proxy Manager. 

>> To add an entire directory to the Proxy Manager, right-click a folder in the Library and 
choose Add Folder Into Proxy Manager.

Once you’ve added clips to the Proxy Manager, the Proxy Manager window opens, providing a 
variety of controls for managing the proxy generation process.

At the top, a Proxy Status area displays the name of selected clips and the resolution with which 
proxies will be generated (user customizable).

The Task Manager is a list that contains all the clips that have been added for generation and 
management. Eight columns display information about the items in the list, and let you sort in either 
ascending or descending order by clicking on that column. The available columns include:

>> Start Frame: Lists the first frame of the clip, by timecode

>> End Frame: Lists the last frame of the clip, by timecode

Creating and Using Proxy Media
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>> Time Elapsed: How long since proxy generation was initiated.

>> Time Left: How much longer it will take for proxy generation to finish.

>> Percentage: How many proxies in the current batch have been generated.

>> Status: The state of proxy generation.

At the bottom of the Task Monitor are five buttons for managing the generation of proxies. These 
buttons change depending on whether or not you’ve selected anything in the list.

>> Check Proxies verifies whether or not proxies already exist.

>> Check Selected Proxies checks the existence of only the selected files. 

>>Generate All Proxies initiates the process of proxy generation for all clips appearing in the list. 

>>Generate Proxies initiates the process of proxy generation for clips you’ve manually selected 
in the list. 

>> Cancel Tasks cancels all proxy generation in progress.

>> Cancel Selected Tasks cancels only the generation of proxies that you’ve selected. 

>> Remove Tasks clears the Task Manager list.

The Proxy Image Scaling options in the Project Settings
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When working with stereo media in DaVinci Resolve, one of the first tasks you must perform is that 
of syncing each stereo pair of clips to act as a single clip. This is easily accomplished so long as 
you’re careful about how you organize your media in the Media Pool.

Each set of right- and left-eye media should always be organized into separate left-eye folders and 
right-eye folders, to facilitate later syncing of these clips using the Stereo 3D Sync command in the 
Media Pool contextual menu. For more information about setting up media for stereo workflows, 
see the “Stereoscopic Workflows” section of Chapter 9, “Preparing and Conforming Projects.”

Organizing Stereo Media
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Camera raw media formats are so named because they capture raw color space data directly from 
the sensor of whatever digital cinema camera did the recording. Raw image data is not human 
readable, and must be debayered or demosaicked to convert the original raw data into image data 
that can be handed off to DaVinci Resolve’s image processing pipeline.

There are three ways you can control how camera raw media is debayered into a useful, “normalized” 
image for adjustment or output:

>> The Camera Raw panel of the Project Settings contain groups of parameters that 
correspond to every camera raw media format that’s supported by DaVinci Resolve. Using 
these parameters in the Camera Raw panel, you can override the original camera metadata 
that was written at the time of recording, and make simultaneous adjustments to all camera 
raw media throughout your project.

>>When you right-click one or more selected camera raw clips in the Media Pool, there are a 
series of “Edit Codec Settings” menu options corresponding to each supported camera 
format in the contextual menu that appears. Choosing one of these commands opens a 
Camera Raw window that exposes controls mirroring those found in the Camera Raw panel 
of the Project Settings.

>> The Camera Raw palette in the Color page lets you individually adjust Camera Raw 
parameters for individual clips in the Timeline.

For more information about each of the Camera Raw formats that can be adjusted in DaVinci 
Resolve, see chapter 5, “Camera Raw Settings.”

Camera Raw Decoding
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If you have a program that someone has delivered as a single media file, with no accompanying EDL 
with which to split it up, you can use DaVinci Resolve’s Scene Detect window to automatically find 
the cut points and split it into individual clips, ready for grading.

To open a clip into the Scene Detect window:

1.	 Open the Media page, and use the Library browser to find and select the clip you need to 
split apart.

2.	 Do one of the following:

>> Click the Scene button at the bottom left of the Media page.

>> Right-click the file and choose Scene Cut Detection.

>> Using the DaVinci control surface, press SHIFT DOWN and DECK/REVIVAL/SCENE on the 
T-bar panel.

The Scene Detect window opens up, containing the clip you selected.

The Scene Detect Window Interface

The Scene Detect Window is divided into three main areas, the Viewers, the Graph, and the Cut 
List. Together, these controls let you analyze the movie, examine the automatically found cuts, and 
manage the Cut List in preparation for sending back to your project.

Using Scene Detection

Scene Detector window
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The Scene Detect Viewers

A set of three viewers appear at the top of the Scene Detect window. These three viewers are 
designed to make it easy to test whether the playhead in the Scene Detect Graph is on a cut 
point or not. The leftmost viewer is the last outgoing frame of a detected cut point. The center 
viewer shows the first incoming frame of that cut point, and the rightmost viewer shows the second 
incoming frame of that cut point. 

If the playhead in the Scene Detect Graph is directly on top of an edit point, the leftmost viewer 
should show a completely different frame than the center and rightmost viewers, which should be 
very similar to one another. This can be seen in the following example. 

If all three viewers appear to display a continuous series of frames, then you’re not looking at  
a cut point.

Underneath the viewers are a series of nine controls.

>> Start: This initiates the scene cut detection process.

>> Transport Controls: A set of seven transport controls include: first frame, step back, play 
reverse, stop, play forward, step forward, last frame.

>> In: Lets you set a red In point, with which to define a range of the Scene Detection 
Graph to prune.

>>Out: Lets you set a cyan Out point, with which to define a range of the Scene Detection 
Graph to prune.

The left image shows the previous clip, center and right the next

No scene cut here as all images are almost the same
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>> Prune: If you’ve identified a number of false positive scene cuts, use the In and Out buttons 
to select a range of scene cuts in the Scene Detect Graph, and then choose Prune Scene 
Cuts to eliminate all scene cuts between these points that are within one frame of another 
scene cut. Within the group of identified cuts, the highest probability cut will remain while 
the other cuts are deleted.

>> Show Cut List: Shows and hides the Cut List, which shows the currently detected scene cuts.

The Scene Detect Graph

The majority of the bottom half of the Scene Detect window, to the left, consists of the Scene 
Detect Graph, which shows the scene detect analysis results after you’ve clicked the Start button.

Detection graph displays potential scene cuts

Frames that Resolve thinks are cut points appear as green vertical “scene cuts” of various heights. 
The height of each scene cut corresponds to the likelihood that frame is really an edit point, and 
not a swish pan, sudden jump in the motion of the frame, or abrupt change in color or lighting, all 
of which can fool the scene detection algorithm.

A horizontal magenta confidence bar lets you choose the threshold of confidence required for 
scene cuts to be added to the Cut List. If you drag this bar up above any shorter scene cuts of low 
confidence, those lines turn gray, and are omitted from the Cut List. 

Note: Dissolves and other transitions are not automatically detected, although dissolves most often 
appear as a triangular cluster of lines peaking in the middle.

Three controls appear underneath the graph.

>> Add: Lets you manually add a scene cut at the current position of the playhead. Sometimes 
two adjacent clips with similar color and lighting will appear to be a single clip to the scene 
detection algorithm. This lets you add scene cuts at frames where they weren’t initially found.

>> Delete: Lets you manually delete a scene cut located at the position of the current frame 
indicator within the graph.
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>> Zoom Slider: Lets you zoom into and out of the Scene Detect Graph to see more or less 
detail as you examine the results. 

Cut List

At the lower right of the Scene Detect window, the Cut List displays one entry for each of the scene 
cuts that intersect the confidence bar.

The cut list shows all currently detected cuts
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Three columns show each cut’s order number, frame number, and timecode value. You can select 
items in the Cut List to evaluate each cut using the three viewers above. Whenever you select a new 
item in the Cut List, the playhead jumps to that frame in the Scene Detect Graph. 

To select items in the Cut List:

>> Click any item in the Cut List.

>> Press N or the Down Arrow to select the next item down.

>> Press P or the Up Arrow to select the next item previous.

As you move up and down the list, you can delete items that you can confirm aren’t real cuts using 
the viewers above. If it’s a long list and you don’t have time to check it all at once, it can be saved for 
later recall using commands found in the Scene Detect Options pop-up menu.

Once you’re finished checking the list and are satisfied that each cut is accurate, you can use it to 
split the media file into individual clips in the Media Pool by clicking “Add Cuts to Media Pool,” 
located immediately below.

The Scene Detect Options Pop-Up Menu

The Options pop-up menu, located at the upper right-hand corner of the Scene Detect window, 
contains a variety of commands.

>> Reset Zoom: Sets the zoom level of the Scene Cut Graph such that the entire clip fits within 
the current width.

>> Reset Marks: Clears the current In and Out points you’ve set.

>> Save SceneCut: Saves the current scene cut detection information, including the probability 
metadata, to disk. SceneCut files use the file extension .sc and can be reimported later to 
continue working on a lengthy scene detection task.

>> Load SceneCut: Imports an existing .sc file into the Scene Detect window. You must first 
open the media file you’re working on into the Scene Detect window before you can load 
a SceneCut file.

>> Save EDL: Exports the Cut List as a CMX-style EDL.

>> Load EDL: Loads a CMX-style EDL into the Cut List, letting you use the cut information from 
the EDL during the Scene Cut Detection process.

>> Auto Cue: When enabled, the playhead jumps to each new scene cut as it’s detected when 
you initiate scene detection. This lets you evaluate each scene cut as it’s found using the 
three viewers above.
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An Example Scene Detect Workflow

This section describes an ideal workflow for using scene detection without an EDL.

To scene detect a media file:

1.	 Locate a media file to scene detect using the Library of the Media page. 

2.	 Verify its frame rate and if it uses drop-frame timecode, and make sure that the “Timeline 
frame rate” and “Use drop frame timecode” parameters in the Master Project Settings match. 
These parameters are not automatically set if the project already has media in the Media Pool, 
and you may have problems if they don’t match your media.

3.	 Right-click the media file, and choose Scene Cut Detection.

4.	 When the Scene Detect window appears, click the Options pop-up menu and choose Auto 
Cue (it should be on by default, but it’s always good to check), then click Start.

	 Scene detection initiates, and you can evaluate each scene cut as it’s found. If any scene cut 
looks wrong (three sequential frames in a row), note its place in the list for future evaluation.

5.	 When Resolve has finished scene detection, move the playhead to some of the shorter scene 
cuts, and verify if they’re actual cuts by checking the three viewers above. If the frames being 
displayed are “different-same-same,” then it’s a genuine cut. 

	 If the frames being displayed are “same-same-same” (actually three sequential frames), then 
these aren’t cuts.

	 Tip: Fast camera motion such as whip pans, sudden changes in lightness such as camera 
flashes, or even film coming up to speed causing the shutter to “flash” can confuse the analysis, 
which looks for large changes in the image.

6.	 If there are numerous low-confidence scene cuts that you’ve verified aren’t cuts, drag the 
magenta confidence bar so that the low-confidence scene cuts fall below it to automatically 
remove them all from the list.

7.	 Next, you may want to move down the Cut List, evaluating each scene cut to verify that it’s 
correct. Click the first scene cut in the list, check it, then press the keyboard down arrow to 
select the next list item down, check it, and repeat until you’ve checked every item in the list. If 
you need to move back up the list, you can press the up arrow to select the previous list item. 
If any item is not a cut point, click the “Minus” button at the bottom left corner of the Scene 
Detect window to eliminate that scene cut.

8.	 If there are sections in the Scene Detect Graph with dense groups of spikes, these are probably 
frames with types of motion that confused the Scene Cut Detector. To delete this unwanted 
“noise” in the data, use the In and Out buttons to isolate the data, and then click “Prune” to 
delete these unwanted scene cuts.
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9.	 If there’s a gap between any two scene cuts that you’re positive should have another scene cut, 
then scrub the playhead or use the transport controls to find the missing cut, and click the “Plus” 
button at the bottom left corner of the Scene Detect window to add another scene cut.

	 Tip: Adjacent shots with very similar ranges of color and contrast may sometimes go undetected 
by the scene detection algorithm. If you know of scenes in the media you’re analyzing that are 
like this, you may want to scrub through them a bit more carefully to make sure you’re not 
missing anything. However, if you find you’ve missed a cut later, you can always use the Split 
Clip control in the Edit page timeline to add a new edit point.

10.	 When you’re confident that the Cut List is accurate, split the media file into individual clips in 
the Media Pool by clicking “Add Cuts to Media Pool.”

11.	 When the Conform Settings dialog appears, click OK if you checked your settings in step 2.

12.	 Close the Scene Detect window.

	 The individually cut up clips of the media file you analyzed now appear in the Media Pool, and 
you can edit the entire sequence of clips into a new Timeline in order, ready for grading. 
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This chapter covers how to capture media from tape directly into the Media Pool in DaVinci Resolve. 
Whether you need to capture a handful of clips to incorporate into an existing project, or you need 
to recapture every clip corresponding to the events of an EDL, you can use the Media page in 
Capture mode to capture from any device-controllable deck via a compatible video interface.

To switch to tape capture in the Media page:

>> Click the Capture button, located to the left of the transport controls underneath the Media 
page Viewer.

The Capture page updates to reflect the relevant controls for editing to tape, and the 
Metadata Editor switches to a dedicated set of capture metadata to help you track the 
resulting clips.

The Tape Capture Interface

While in Capture mode, the Media page is used to control the VTR, in order to establish In and Out 
points for logging or capturing a selected range of the tape.  

>> Transport Controls: The transport controls, while similar in appearance to those used while 
in Playback mode, now work to control the VTR.

Tape Ingest

Tape Capture viewer in the Media page
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>> Shuttle Control: A Shuttle Control appears in what was formerly the Scrubber Bar, which 
lets you shuttle through the range of reverse and forward speeds compatible with the 
connected deck.

>> In and Out Controls: In Capture mode, the In and Out buttons to the right of the transport 
controls define a range of the tape from which to capture.

>>Metadata Editor: In Capture mode, the Metadata Editor automatically switches to the 
Capture set of metadata fields. Populating File Name Prefix updates the file name preview 
that’s shown above in the Header, that also shows the Capture directory, Resolution, and 
Frame Rate specified in the Deck Capture and Playback panel of the Project Settings.

Setting Up to Capture From Tape

Before you begin capturing from tape, you need to adjust a variety of settings in the Deck Capture 
and Playback panel of the Project Settings. Two groups of settings, in particular, need to be defined.

Editable capture metadata 
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Capture and Playback Project Settings

These settings affect both capture and playback when using the Tape Ingest options of the Media 
page, or the Tape Output options of the Deliver page.

>> Video capture and playback: You can choose the video format (frame size and frame rate) 
with which to output to tape from this pop-up menu. HD timelines can be downconverted 
to SD, and SD timelines can be upconverted to HD using the format conversion of your 
DeckLink card.

>> Enable stereo video: A checkbox that enables the Blackmagic Design DeckLink HD Extreme 
3D+ to ingest and output muxed stereoscopic video when used with supported VTRs, such 
as HDCAM SR decks with 4:2:2 x 2 mode. (When muxed stereoscopic signals are ingested, 
each eye is separated into individual left-eye and right-eye image files.)

>> Video connection operates as: Selects between the available signal options: YUV 422 
SDI, RGB 444 Dual Link and 444 single link using 3 or 6 Gb/s. Which options are available 
depend on which video capture card you are using. All three are available when using the 
Blackmagic Design DeckLink HD Extreme 3+ card.

>> Video/Data Level: Lets you specify the data range (normally scaled or full range) that’s used 
when ingesting from or outputting to tape. This option switches the data range of the signal 
output by your video capture card, but only during capture from tape in the Media page, 
or output to tape in the Deliver page. When capture or output is not currently occurring, 
your video capture card goes back to using the identically named data range setting in the 
Master Project Settings pane, which governs how you monitor the signal being output on 
an external broadcast display or projector.

>> Video bit depth: 10-bit is the only available option.

>> Use deck autoedit: If supported by your video deck, this is the best method to record video 
to the deck, as it enables the deck to roll the edit using the specified preroll, and control 
the edits via serial device control. If this checkbox is turned off, a basic edit On/Off mode 
is used by the deck, with the potential for frame inaccuracies if the “Non auto edit timing” 
setting is not properly adjusted.

>>Non auto edit timing: Adjusts the edit synchronization of the connected deck when auto 
edit is turned off.

>> Deck preroll: Sets the number of seconds for preroll. How much is appropriate depends on 
the performance of your deck.

>> Video output sync source: When using a DeckLink card this is set to Auto. Other capture 
cards may require you to set the sync source to “Reference” for playout and “Input” for 
ingest. This setting is only available if you have the DVS card installed on your system.

>> Add 3:2 pulldown: Inserts or removes the 3:2 pulldown required to record or play 23.98 fps 
media to or from a 29.97 tape format.
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Capture

These settings are used when you use the Capture mode in the Media page to capture clips from 
tape into the Media Pool.

>> Video Format: The format captured media will be saved to. The available options are DPX 
and QuickTime.

>> Codec: The codec used to write captured media. Options include the various type of Apple 
ProRes, 8 and 10-bit YUV 422, 10-bit RGB, and the various types of DNxHD.

>> Save clips to: A field that displays the directory path to which media files captured from 
tape are written. You want to choose a volume that’s fast enough to accommodate the data 
rate of the media format you’re capturing.

>> Browse: Click this button to choose a directory to write captured media to. The 
directory you choose appears in the field above.

>> Save in this folder path: A series of checkboxes lets you specify what other information to 
use to define the directory hierarchy that will hold the captured media. Every checkbox you 
turn on adds an additional directory with a name defined by that checkbox’s metadata. You 
can choose any or all of the following: Program name, Clip number, Reel number, Roll/Card.

>> Apply reel name to: Lets you choose how to write the reel name. Two checkboxes let you 
write the reel name to the file’s name, and/or to the Header data.

>> Use prefix: A field lets you type in a prefix to be used in the media file’s name. This lets you 
add text identification that will make the media more easily identifiable and searchable.

>> Apply prefix to: Two checkboxes let you choose to use the prefix you typed in the file name, 
and/or in the folder name.

>> Use frame number with: When capturing to image sequences, you can choose how many 
digits to use when writing the frame number into the name of each frame file.

>> Enable audio input: Turn this checkbox on to capture audio along with the video. If 
you’re capturing QuickTime or MXF files, the audio will be written as additional tracks 
inside each file. If you’re capturing to a DPX image sequence, then a Broadcast .wav file 
is recorded separately.

>> Input: Lets you choose how many tracks of audio to capture.

The Three Methods of Capture

Once you’ve set up all relevant settings in the Project Settings window, including at minimum 
“Video Capture and Playback,” “Capture Clips Saved to,” and Apply Reel Name to” settings, then 
you’re ready to start capturing. Depending on your workflow, there are three methods of capturing 
from tape that you can use.

For all capture methods, media can only be ingested as DPX image sequences.
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Using Capture Now

If you simply need to capture a section of tape quickly, you can use the Capture Now command.

To Capture Now:

1.	 Use the transport controls and the In button to identify what you want to capture.

2.	 Enter all relevant information into the various fields of the Metadata Editor. The Header 
updates to show a preview of the file name that will be saved.

3.	 Use the transport controls to start playback, and then click the Capture Now button at the 
bottom of the Metadata Editor.

4.	 When the section of tape you wanted to record has finished, click Capture Now again to 
stop capture.

	 A new clip appears in the Media Pool, automatically placed in a new folder in the Media Pool with 
a name defined by the timecode value converted into a frame count, based on the ingest frame 
rate. For example, 00086400.dpx is the file name of a clip captured at timecode 01:00:00:00.

Logging and Capturing Individual Clips

If you’re capturing an exact range of tape, or multiple sections at once, you can also work by logging 
each section of tape you want to capture in advance, before using the Capture Clip or Batch Clips 
commands in a second step.

To capture a single clip using device control:

1.	 Use the transport controls to find the beginning of the section of tape you want to record, and 
click the In button. Then, find the end of the section of tape you want to record, and press the 
Out button.

2.	 Enter all relevant information into the various fields of the Metadata Editor. The Header 
updates to show a preview of the file name that will be saved.

3.	 When you’re finished, click Capture Clip.

	 Deck control is automatically used to play through the specified range of tape and capture 
that clip. When capture is complete, the new clip appears in the Media Pool.
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Logging and Capturing Multiple Clips

For efficiency’s sake, you can also log multiple clips at once, from multiple tapes if necessary, and 
then batch capture them all at once.

To log one or more clips:

1.	 Use the transport controls to find the beginning of the section of tape you want to record, and 
click the In button. Then, find the end of the section of tape you want to record, and press the 
Out button.

2.	 Enter all relevant information into the various fields of the Metadata Editor. The Header 
updates to show a preview of the file name that will be saved.

3.	 When you’re finished, click Log Clip.

	 That clip is added to the Media Pool as an offline tape clip, indicated by a black icon with a 
tape badge.

To batch capture one or more logged clips:

1.	 (Optional) Put the Media Pool into List view, and click the Reel No column header to sort the 
Media Pool clips by reel number. This makes it easier to select a range of clips to capture from 
a particular reel. 

2.	 Select one or more offline tape clips in the Media Pool that come from a particular reel.

3.	 Click Batch Clips, at the bottom of the Metadata Editor. To interrupt capture at any time, click 
Batch Clips again.

Logged clip in the Media Pool prior to capture



DAVINCI RESOLVE COLORIST REFERENCE MANUAL

171

MEDIA4

	 Deck control is automatically used to play through the current tape in the VTR and capture 
every logged clip you’ve selected that can be found on that tape, starting with the clip with the 
lowest timecode value and ending with the clip having the highest timecode value. A progress 
bar with accompanying text shows how much longer to go until capture is complete. As each 
clip is captured, its corresponding logged clip in the Media Pool updates with a thumbnail 
reflecting the captured media. 

	 When Resolve finishes capturing all clips from a particular reel, Batch Capture stops. 

Batch Capture Via EDL

You can also use an EDL to create offline tape clips, one for each event in the EDL, with which to 
batch capture all the media necessary to conform a project from tape.

To import an EDL as a batch capture list:

1.	 Open the Project Settings, click Master Project Settings, and make sure of the following:

>> Set “Timeline frame rate” to the frame rate of your EDL.

>> Turn on “Use drop frame timecode” if your EDL requires it.

>>Make sure “Use Timecode” is set to “Embedded in the source clip”

>> Turn on “Assist using reel numbers from the”

2.	 Choose File > Import Batch List From EDL.

3.	 When a Conform Settings dialog appears asking you to confirm the current Project Settings, 
click OK if the settings are good.

4.	 Use the controls of the Select EDL files dialog to select one or more EDLs, then click Open.  
If you select multiple EDLs, then every event in each EDL is imported at once.

5.	 In the dialog that appears next, choose a frame rate to conform the EDL at, and click OK.

	 Each event in the EDL now appears as offline tape clips in the Media Pool, ready for capturing. If 
you load an EDL and there are already clips in the Media Pool that have the same reel name and 
start timecode as events in the EDL, Resolve will not create new offline tape clips for those.
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6.	 (Optional) Put the Media Pool into List view, and click the Reel No column header to sort the 
Media Pool clips by reel number. This makes it easier to select a range of clips to capture from 
a particular reel.

7.	 (Optional) If there are any offline clips that you don’t need to capture, you can remove them 
from the Media Pool by right-clicking them and choosing Remove Selected Clips.

8.	 Select which of the offline tape clips you want to capture. It’s best to select ranges of clips that 
come from the same reel.

9.	 Click the Capture mode button to the left of the transport controls, and then click Batch Clips 
to begin capture. To interrupt capture at any time, click Batch Clips again. Deck control is 
automatically used to play through the current tape in the VTR and capture every logged 
clip you’ve selected that can be found on that tape, starting with the clip with the lowest 
timecode value and ending with the clip having the highest timecode value. A progress bar 
with accompanying text shows how much longer to go until capture is complete. As each 
clip is captured, its corresponding logged clip in the Media Pool updates with a thumbnail 
reflecting the captured media. 

	 When Resolve finishes capturing all clips from a particular reel, Batch Capture stops.

A set of logged clips imported from an EDL


